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INTRODUCTION
Tax Increment Financing is a method of financing improvements and development in an
area which has been determined to be blighted according to the criteria set forth in
SDCL 11-9. All this is done without incurring a general obligation for the taxpayers of
the entire City.

The assessed value of a district is determined by the South Dakota Department of
Revenue at the time the district is created by the City Council. This valuation is termed
the Tax Increment Base Valuation for the district, or simply the “base valuation.” As the
property taxes for the property are paid, that portion of the taxes paid on the Base
Valuation continue to go to those entities, (City, County, School, etc.), which levy
property taxes.

When in succeeding years, the assessed valuation of the district increases, the total
property taxes paid by the owners of property in the district will increase accordingly.
That increase in taxable valuation is the “increment.” When the tax bills are paid, only
that portion of the tax bill which results from the Base Valuation, is paid to the taxing
entities. The remainder of the tax bill, known as the tax increment, is deposited in a
special fund. It is this plan which determines how these accumulated funds will be used.
It is anticipated that one or more of the properties in this proposed Tax Increment District
will be used for commercial purposes. The creation of this Tax Increment District for
economic development purposes will not require an additional levy to make up for the
School District's share of the property taxes included in the Tax Increment.

This financing method is invaluable for encouraging growth and development of blighted
properties with special re-development problems, since the amount of funds available for
use by the project plan is directly related to the increase in valuation which a given
project or development will create.

OVERVIEW

This Revised Tax Increment Project Plan proposes to increase the allowable projects
costs included in the previously approved project plan. The original Tax Increment
District Project Plan was approved on December 20, 2004. That plan proposed to assist
in funding the acquisition, demolition, clean up and redevelopment of the former Federal
Beef meat packing plant property located west of West Boulevard North and [-190 and
north of Omaha Street and off-site water improvements to assist in the redevelopment of
the area. The plant was destroyed by fire in January 2002. Signalization of the
intersection of 12" Street and Omaha Street was included in the original Project Plan.
The estimated cost of the project improvements included in the original Project Plan for
Phase | was $3,425,000. The Developer's share was $3,250,000 and the City’s share
was $175,000. Phase |l of the Project Plan identified $2,725,000 for water system
improvements to be funded by the City if funding could be identified.

At the Tax Increment Financing Committee meeting held on September 19, 2005, the
Committee reviewed a request by Century Development to expand the original Project
Plan. Century Development requested the inclusion of an additional $600,000 to
reconstruct Philadelphia Street in a new location. The Tax Increment Financing
Committee recommended approval of the following additions in project improvements to
the previously approved Tax Increment District: Phase | Improvements Philadelpia
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Street relocation - $600,000 and additional off-site water improvements (by City) -
$205,000: and additional Phase i Project costs (by City) of: Rapid Creek Pedestrian
Crossing (Rapid Creek and Twelvth Street) - $40,000; and inclusion of the rehabilitation
of the hydroelectric plant at an unidentified cost. For purposes of this project plan staff
has identified $755,000 as an estimate of the cost of the rehabilitation of the
hydroelectric plant. There is no funding source at this time for the additional Phase |l
project costs of $1,000,000. In addition, the Tax Increment Financing Committee
recommended increasing the developer's interest rate to a maximum of 9%.

The clean up and redevelopment of the Federal Beef property and the water line
improvements will eliminate a blighted and potentially dangerous site, as well as
enhance the ability for new development to occur increasing the community's economic
vitality and expanding the City's property tax base. This district is determined to qualify
as an economic development Tax Increment District as commercial development is
anticipated within the district.

The applicant's share of the estimated cost of the improvements will be financed at an
estimated 9% interest rate. The City’s estimated cost of improvements will be financed
at a 6% interest rate. No funding sources have been identified for the City’s proposed
project costs. It should be noted that all project expenditures (including both Phase |
and Phase 1) must be completed within five years of the creation of the Tax Increment
District or by December 2009. The City's project improvements will not occur unless
funding can be identified and adequate revenues are projected to provide repayment of
those costs. Should the tax increment revenues exceed the anticipated loan payments,
the district debt would be retired early resuiting in the full value of the property being
returned to the tax rolis more quickly.

PROJECT PLAN SUMMARY

This plan establishes the total project costs, as well as the Tax Increment District funded
costs.

Elements of the Revised Project Plan

This Revised Project Plan, as required by SDCL 11-9-13, will address the following
elements:

Public Works and Other Improvements;
Economic Feasibility Study;

Project Costs;

Fiscal Impact Statement; and,
Financing Method Description.

g b WhN =
Pea-Rair et i

Additionally, the following exhibits are offered:
[. General Vicinity map;
il Tax Increment district Boundary Map;
Il Map of Existing Zoning,
V. Map of Existing Land Use; and,
V. Map of Public and Other Improvements.
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The Statement of Method for Relocating Displaced Persons, as well as the Statement of
Changes Needed in Master Plan, Building Codes and Ordinances do not apply to this
Project Plan and have not been included in this document.

ELEMENTS OF THE REVISED PROJECT PLAN

1. PUBLIC WORKS AND OTHER IMPROVEMENTS

The project plan includes costs associated with land acquisition, demolition, clean up,
grading, off-site water system improvements and the relocation of Philadelphia Street.
In addition the costs of signalization of the intersection of 12" Street and Omaha Street
are included in Phase |. The proposed Phase 1l includes funding for: a pedestrian
crossing at Rapid Creek and Twelfth Street; the expansion of the water system serving
the residential neighborhood located north of Philadelphia Street; and, the restoration of

the hydroelectric plant.

2. ECONOMIC FEASIBILITY STUDY

Current Valuation — Tax Increment District Number Fifty is proposed for creation in
accordance with SDCL 11-9-2 to 11-9-11. A vicinity map as well as a boundary map is
attached. As of this date, the assessed valuation for the proposed district is projected as
$9,833,000. In accordance with SDCL 11-9-20, certification of the base value will be
requested from the South Dakota Department of Revenue following creation and
approval of the district by the City Council.

ANTICIPATED CERTIFIED BASE VALUATION OF PROPERTY IN TID #50
$9,833,000

Expected Increase in Valuation —

ESTIMATED FUTURE VALUATION OF PROPOSED DISTRICT

Estimated Assessed Value of District $ 9,833,000
Estimated Assessed Value of project (year 20) $ 77,500,000
Other Anticipated Increases in Assessed Value $ 0
Estimated Increase in Assessed Value of Land* $ 0
Estimated Total Valuation (year 20) $ 87,333,000

*For purposes of this Tax Increment District, the increase in land value is not
included in these estimates. Any additional value will pay off the loan earlier than
anticipated.

Revenue Estimates from Tax Increments

The Plan anticipates 36 semi-annual payments over 18 years; however, because of the
uncertainty associated with the development, the plan identifies a 20 year payback
schedule. The potential negative short-term impact on the various taxing entities will be
offset by the increase in the tax base in future years.
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2004 Tax Levies and Percentage of Total Levy

Percentage of

Taxing Entity Tax Levy Total Levy
Rapid City Area School District 10.4134 56.3%
Pennington County 4.9092 26.5%
City of Rapid City 3.1493 17.0%
West Dakota Water District .0331 2%
Total Mill Levy 17.9892 100%

Anticipated 2004 Owner Qccupied Tax Rate: 0.0179892

The estimated tax increment available to pay for project costs in the Plan can be
calculated by multiplying the anticipated tax rate by the increment in valuation. This
calculation results in the following tax increments, which become available as taxes are
paid for the applicable periods.

2004 Tax Levies and Percentage of Total Levy

Percentage of

Taxing Entity Tax Levy Total Levy
Rapid City Area School District 16.9185 87.7%
Pennington County 4.9092 19.6%
City of Rapid City 3.1493 12.6%
West Dakota Water District 0331 1%
Total Mill Levy 24,2172 100%

Anticipated 2004 Non Agriculture Tax Rate: 0.0242172

The estimated tax increment available to pay for project costs in the Plan can be
calculated by multiplying the anticipated tax rate by the increment in valuation. This
calculation results in the following tax increments, which become available as taxes are

paid for the applicable periods.
PROJECTED TAX INCREMENT INCOME

YEAR PROJECTED TAX
ASSESSMT TAXES INCREMENT INCREMENT
DATE PAID IN VALUATION PAYMENTS TOTALS
Nov 2007 $ 0 $ 0
2005
Nov 2008 $ 0 $ o
2008
Nov. 2009 $0 $ 0
2007
Nov. 2010 $ 17,500,000(00)* $ 314,811

2008 $ 5,875,000(NAY** $ 142,276 $ 457,087
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Nov. 2011 $ 17,500,000(00) $ 314,811
2009 $ 10,750,000(NA) $ 260,335 § 575146
Nov. 2012 $ 27,500,000(00) $ 494,703
2010 $ 16,625,000(NA) $ 402610 $ 897,313
Nov. 2013 $ 35,000,000(00) § 629,622
2011 $ 21,500,000(NA) $ 520,670 $1,150,292
Nov. 2014 $ 45,000,000(C0) $ 809,514
2012 $ 22,500,000(NA) $ 544,887 $1,354,401
Nov 2015 $ 45,000,000(C0) ¢ 809,514
2013 $ 22,500,000(NA) $ 544,887 $1,354,401
Nov 2016 $ 55,000,000(C0) $ 989,406
2014 $ 22,500,000(NA) $ 544,887 $1,534,293
Nov 2017 $ 55,000,000(00) $ 989,406
2015 $ 22,500,000(NA) $ 544887 $1,534,293
Nov 2018 $ 55,000,000(00) $ 989,406
2016 $ 22,500,000(NA) $ 544,887 $1,534,293
Nov 2019 $55,000,000(00) $ 989,406
2017 $ 22,500,000({NA) $ 544,887 $1,534,203
Nov 2020 $ 55,000,000(0C0) § 989,406
2018 $ 22,500,000(NA) $ 544,887 $1,534,203
Nov 2021 $ 55,000,000(C0) ¢ 989,406
2019 $ 22,500,000(NA) $ 544,887 $1,534,203
Nov 2022 $ 55,000,000(00) $ 989,406
2020 $ 22,500,000(NA) $ 544,887 $1,534,283
Nov 2023 $ 55,000,000(00) $ 989,406
2021 $ 22,500,000({NA) $ 544,887 $1,534,293
Nov 2024 $ 55,000,000(00) § 989,406
2022 $ 22,500,000(NA) $ 544,887 $1,534,293

*Owner Occupied properties
**Non Agriculture properties

TOTAL TAX INCREMENT EXPECTED TO ACCRUE BY 12/20/24:
$ 19,597,277

NOTE: Tax increment payments are calculated using 100% of estimated future
increment in property valuation and 100% of the 2004 mill levy.
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3. REVISED PHASE | PROJECT COSTS

Capital Costs — The revised Phase | capital costs total $3,910,122, includes the funding
for demolition, clean up, grading, land acquisition of the Federal Beef site, off-site water
system improvements, signalization at 12" Street and Omaha Street and the relocation

of Philadelphia Street.

Financing Costs — The financing costs for this Project Plan are dependent on the interest
rate obtained. The anticipated interest rate used for this projection is 6% for the City and
9% for the applicant acquired financing. It is estimated that the Phase | financing costs
will total $4.208,291. If a lower interest rate is obtained, the project costs will be repaid
more quickly and the property will be returned to the tax rolls sooner.

Professional Service Costs — Professional service costs for engineering in the amount of
$90,000 have been included in the Project Plan.

Relocation Costs — No relocation costs are anticipated in the Project Plan.

Organizational Costs — No organizational costs are anticipated in the Project Plan.

Contingency Costs — Contingency costs in the amount of $229,878 have been included
in the Project Plan.

Necessary and Convenient Payments — No other necessary and convenient costs are
anticipated in the Project Plan.

Imputed Administrative Costs — All Tax Increment District actions require municipal staff
time to prepare and enact. The City shall be reimbursed on December 15, 2009, for its
administrative costs in the amount of $2050. However, in no case shall the City be
reimbursed less than $1 on December 15, 2009.

ESTIMATED PROJECT COSTS TO BE PAID BY THE TAX INCREMENT DISTRICT

Phase |
Capital Costs:

Demolition, Clean up and grading $ 1,150,000.00
Land Acguisition $ 1,000,000.00
Off-site Water system $ 455,000.00
Grading, utilities, streets $ 530,122.00
Signalization $ 175,000.00
Philadelphia Street $ 600,000.00
Professional Service Costs $ 90,000.00
Financing Costs:
Financing interest $ 5,163,302.10
Contingency Costs: $ 229,878.00
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Relocation Costs: $ 0
Organizational Costs; $ 0
Necessary and Convenient Costs: $ 0
TOTAL $ 9,393,309.10
Imputed Administrative Costs*

City of Rapid City $ 2,050

*The imputed administrative costs are interest-free, are not included in the total project
costs, and are to be paid from the balance remaining in the TID #50 fund available to the
City Finance Officer on December 15, 2009,

CITY FUNDED PHASE | PROJECT COSTS:

Capital Costs:

Signalization 3 175,000.00

Off-site water improvements $ 205,000.00

Professional Service Costs $ 0
Financing Costs:

Financing interest $ 234,158.20
Contingency Costs: 3 0
Relocation Costs: $ 0
Organizational Costs: 3 0
Necessary and Convenient Costs: $ 0
TOTAL $ 614,158.20
DEVELOPER A FUNDED PHASE | PROJECT COSTS:

Capital Costs:

Demolition, Clean up and grading $ 1,150,000.00

Land Acquisition $ 1,000,000.00

Off-site Water system $  250,000.00

Grading, utilities, streets $ 530,122.00
Professional Service Costs $ 90,000.00
Financing Costs:

Financing interest $ 4,208,290.12
Contingency Costs: $ 229,878.00
Relocation Costs: $ 0
Organizational Costs: $ 0
Necessary and Convenient Costs: $ 0
TOTAL $ 7,458,290.10
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DEVELOPER B FUNDED PHASE | PROJECT COSTS:

Capital Costs:

Phitadelphia Street improvements $ 600,000.00
Financing Costs:

Financing interest $ 720,860.88
Contingency Costs: 3 0
Relocation Costs: $ 0
Organizational Costs: $ 0
Necessary and Convenient Costs: $ 0
TOTAL $ 1,320,860.80

4. PHASE Il FUTURE PROJECT COSTS

Capital Costs — The capital costs of $2,500,000 for Phase Il of the Revised Project Plan
includes the funding for the expansion of the North Rapid Water System. In addition,
capital costs for Phase 11 of the Project Plan includes the funding of a pedestrian bridge
over Rapid Creek at Twelveth Street in the amount of $40,000 along with $755,000 for
the restoration of the hydroelectric plant located on City property.

Professional Service Costs — Professional service costs for engineering in the amount of
$225 000 have been included in the Phase Il Project Plan.

Financing Costs — The financing costs for Phase Il of the Project Plan are dependent on
the interest rate obtained. The anticipated interest rate used for this projection is 6% for
the City. It is estimated that the financing costs will total $3,158,384.06. If a lower
interest rate is obtained, the project costs will be repaid more quickly and the property
will be returned to the tax rolls sooner.

PHASE I
ESTIMATED PROJECT COSTS TO BE PAID BY THE TAX INCREMENT DISTRICT

Capital Costs:

Water System Improvements $ 2,500,000.00

Pedestrian Bridge 3 40,000.00

Restoration of Hydroelectric Plant $ 755,000.00
Professional Service Costs $ 225,000.00
Financing Costs:

Financing interest $ 3,158,384.06
Contingency Costs: $ 0
Relocation Costs: $ 0
Organizational Costs: $ 0
Necessary and Convenient Costs: $ 0
TOTAL $ 6,678,384.06

TOTAL PROJECT COSTS FOR PHASE | AND PHASE I $16.071,0693
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5, FISCAL IMPACT STATEMENT

The impact on taxing entities can be derived from determining the tax increment
anticipated during the life of the district. The true impact on taxing entities of the Plan is
the increase in valuation of the property within the Tax Increment District. The taxing
entities are only foregoing that income during the life of the district and will realize that
income as soon as the debt from the project costs in the Plan is retired. The purpose of
this Plan is to encourage that increase in valuation.

At first glance it may appear that the negative impact on the various entities is notable.
But when it is considered that without the use of the Tax Increment Finance proposed in
this plan it is very likely that there would be no increase in the taxable value of the
property within this district or, at least, any increase would be significantly delayed, the

impact can be considered truly positive.

NET IMPACT ON TAXING ENTITIES

Year Valuation Schools** | County City Water Tax
Increment
Paid Increase
2006 0 $0 $0 $0 $0 30
2007 0 $0 $0 $0 $0 $0
2008 0 30 $0 $0 $0 $0
2008 0 $0 $0 $0 $0 $0
2010 | $ 17,500,000(00) $0 $83,425 $53,518 $629 | $ 314,811
$ 5,875,000(NA) 30 $27,886 $27,886 $142 | $ 142,276
2011 | $ 17,500,000(00) $0 $83,245 $53,518 $629 |§ 314,811
$ 10,750,000(NA) $0 $51,025 $32,802 $260 | § 260,335
2012 | $ 27,500,000(00) $0 $131,006 | $84,100 $989 | $ 494,703
$ 16,625,000(NA) $0 $78,912 | $50,729 $403 | $ 402,610
2013 | $ 35,000,000(00) $0 $166,849 | $107,036 | $1259 | $ 629,622
$ 21,500,000(NA) $0 $102,051 | $65,604 $521 $ 520,670
2014 | $ 45,000,000{(00) $0 $214,521 | $137,617 $1619 | § 809,514
$ 22,500,000(NA) $0 $196,798 | $ 68,656 $545 | $ 544,887
2015 | $ 45,000,000(00) $0 $214,521 | $137,617 | $1619 | $ 809,514
$ 22,500,000(NA) $0 $106,798 | $68,656 $545 | $ 544,887
2016 | $ 55,000,000(00) $0 $262,192 | $168,199 | $1619 | § 989,406
$ 22,500,000(NA) $0 $106,798 | $68,656 $545 | $ 544,887
2017 | $ 55,000,000(00) $0 $262,129 | $168,199 | $1619 | $ 989,406
$ 22,500,000(NA) $0 $106,798 | $68,656 $545 | $ 544,887
2018 | $ 55,000,000(00) $0 $262,129 | $168,199 | $1619 | $ 989,406
$ 22,500,000(NA) $0 $106,798 | $68,656 $545 | $ 544,887
2019 | $ 55,000,000(Q0) $0 $262,129 | $168,199 | $1619 | $ 989,406
$ 22,500,000(NA) $0 $106,798 | $68,656 $545 | $ 544,887
2020 | $ 55,000,000(00) $0 $262,129 | $168,199 | $1619 | $ 989,406
$ 22,500,000(NA} $0 $106,798 | $68,656 $545 | $ 544,887
2021 | $ 55,000,000(00) $0 $262,129 | $168,199 | $1619 | $ 989,406
$ 22,500,000({NA) $0 $106,798 | 68,656 $545 | § 544,887
2022 | $ 55,000,000(00) $0 $262,129 | $168,199 | $1619 | $ 989.406
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$ 22,500,000(NA) $0 $106,798 | 368,656 $545 | $ 544,887

2023 | $ 55,000,000(00) $0 $262,129 | $168,199 | $1619 | $ 989,406
$ 22,500,000(NA) $C $106,798 | $68,656 $545 | § 544,887
2024 | $ 55,000,000(00) $0 $262,129 | $168,199 | $1619 | § 989,406

$ 22 500,000(NA) $0 $106,798 | $68,656 $545 | § 544,887

*The Plan anticipates semi-annual payments over years; however, the district may run
up to 20 years to insure repayment of the project costs.

«“*pyrsuant to State Statute, the School District does not lose tax revenue as a result of
the creation of the Tax Increment District.

6. FINANCING METHOD

The financing method to be used in the funding of this Plan is to be obtained by the
applicants for their share of the costs and by the City for the City's share of the costs.
The applicants and the City will be responsible for any interest payments due for their
share of the costs that are not available from Tax Increment District #50 on a percentage
of total project cost basis for Phase | costs. All Phase | costs will be repaid prior to the
repayment of any Phase Il costs. If the tax increment revenues exceed the anticipated
loan payments, the debt will be retired early.

The debt on the Tax Increment District Project Costs covered in the Plan will be retired
by deposits made in the Tax Increment District as taxes are paid on the property in
succeeding years. The City of Rapid City Finance Officer will make the disbursements
from that fund in accordance with this Plan. As nine percent (9%) of the total costs for
Phase | project costs will be incurred by the City, nine percent (9%) of the annual
incremental revenues will be disbursed to the City until all of the City’s expenses have
been paid or the 20 year maximum time frame has run. As such, 77% of the revenues
will be used to reimburse Developer A’'s costs until all of Developer A’s costs have been
reimbursed or the Tax Increment Distrcit expires at the end of 20 years. In addition,
14% of the incremental revenues will be used to reimburse Developer B's costs until ali
of Developer B's expenses are repaid or the 20 year maxmimum time frame for the

district has run.

It is anticipated that the City’s Phase | project costs and interest will be repaid by the end
of 2016. Once the City's Phase | expenses are paid, the balance of the funds will be
distributed on a percentage basis with 84% of the revenues going to pay off Developer
A's project costs and interest and 16% of the revenues going to pay off Developer B's
project costs and interest.

According to SDCL 11-9-25, positive tax increments will be allocated to that fund until
the debt from the project costs is retired or fifteen years following the last expenditure
from the Project Plan whichever comes first. The final payment for Phase | Project
Costs from this Plan is scheduled to be made on June 1, 2018. The final payment for
Phase Il Project Costs from this Plan is scheduled to be made on December 1, 2022,
however, the district may run the full 20 years if necessary to insure repayment.

If the Phase Il projects are undertaken by December 20, 2009, the balance of the
incremental payments received after the last payments are made to the two developers

11
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will be made to the City until all expenses are repaid or the 20 year maximimum time
frame for the district has run.

There are four amortization schedules attached to this plan: “City Spreadsheet” shows
the repayment of the City's Phase | project costs using a 6% interest rate. “Fed Beef
Spreadsheet” shows the repayment of Developer A's expenses using a 9% interest rate.
“Century Spreadsheet” shows the repayment of Developer B’'s expenses using a 9%
interest rate. “City Phase |l Spreadsheet” shows the repayment of the City’s Phase il
expenses using a 6% interest rate.

12
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Amortization Table

The amortization table at the end of this worksheet calculates the principal and interest payments, ending balance,
and cumulative interest for any 48 consecutive payment periods of & loan.
# To use the table, change the values in the Inital Data section of the worksheet.
# To print the table, choose Print from the File menu. The print area is set to A1:G77.
+ If you increase the term of the loan or the number of payments, you will need to add more payment periods
to the table. Select cells A75:G77, then drag the Fill handle {+) into the celis below the table.

& Most formulas on this worksheet are contained in defined names. To see the names and formulas,

choose Name from the Insert menu, and then choose Define. Select a name from the list

{'Amortization Table'lInterest, for example}.

LOAN DATA D
Loan amount:]  $380,000.00
Annual interest rate:|6.00%
Term in years:|19
Payments per year:|2
First payment due:|6/1/2008

PERIODIC PAYMENT

Table starts at date:
or at payment number: |1

Entered payment:  $30,743.00 The table uses the calculated periodic payment amount,
Calculated payment: $16,894.55 unless you enter a value for "Entered payment.”
CALCULATIONS
Use payment of: $30,743.00 Beginning balance at payment 1: $380,000.00
1st payment in table: 1 Cumulative interest prior to payment 1 $0.00

Payment Beginning Ending Cumulative
No. Date Balance Interest Principal Balance Interest
1 6/1/2006 380,000.00 11,400.00 0.00 391,400.00 11,742.00
2 12/1/2006 391,400.00 11,742.00 0.00 403,142.00 23,484.00
3 6/1/2007 403,142.00 12,094.26 0.00 415,236.27 35,578.26
4 12/1/2007 415,236.27 12,457.09 0.00 427,6893.35 48,035.35
5 6/1/2008 427,693.35 12,830.80 0.00 440,524.15 60,866.15
6 12/1/2008 440,524 .15 13,215.72 0.00 453,739.87 74,081.87
7 6/1/2009 453,739.87 13,612.20 0.00 487,352.07 87,694.07
8 12/1/2009 467,352.07 14,020.56 0.00 481,372.63 101,714.63
9 6/1/2010 481,372.63 14,441.18 6,607.82 474,764.81 116,155.81
10 12/1/2010 474,764 .81 14,242.94 6,806.06 467,958.75 130,398.75
11 6/1/2011 467,958.75 14,038.76 12,632.24 455,326.51 144,437.52
12 12/1/2011 455,326.51 13,659.80 13,011.20 442,315.31 158,097.31
13 6/1/2012 442,315.31 13,269.46 28,340.54 413,974.77 171,366.77
14 12/1/2012 413,974.77 12,419.24 29,190.76 384,784.01 183,786.01
15 8/1/2013 384,784.01 11,543.52 41,798.48 34298553 195,329.53
16 12/1/2013 342,985.53 10,289.57 43,052.43 299,933.10 205,619.10
17 6/1/2014 299,933.10 8,997.99 53,797.01 246,136.09 214,617.09
18 12/1/2014 246,136.09 7,384.08 55,410.92 180,725.17 222,001.18
19 6/1/2015 190,725.17 5,721.76 57,073.24 133,651.93 227,722.93
20 12/1/2015 133,651.93 4,009.56 58,785.44 74,866.49 231,732.49
21 6/1/2016 74,866.49 2,245.99 68,876.01 5,990.48 233,978.48
22 12/1/20186 5,990.48 179.71 5,000.48 0.00 234,158.20
23 6/1/2017 0.00 0.00 0.00 0.60 234,158.20
24 12/1/2017 0.00 0.00 0.00 0.00 234,158.20
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Payment Beginning Ending Cumulative
No. Date Balance Interest Principal Balance Inferest
25 6/1/2018 0.00 0.00 0.00 0.00 234,158.20
26 12/1/2018 0.00 0.00 0.00 0.00 234,158.20
27 6/1/2019 0.00 0.00 0.00 0.00 234,158.20
28 12/1/2019 0.00 0.00 0.00 0.00 234,158.20
29 6/1/2020 0.00 0.00 0.00 0.00 234,158.20
30 12/1/2020 0.00 0.00 0.00 0.00 234,158.20
31 6/1/2021 0.00 0.00 0.00 0.00 234,158.20
32 12/1/2021 0.00 0.00 0.00 0.00 234,158.20
33 6/1/2022 0.00 0.00 0.00 0.00 234,158.20
34 12/1/2022 0.00 0.00 0.00 0.00 234,158.20
35 6/1/2023 0.00 0.00 0.00 0.00 234,158.20
36 12/1/2023 0.00 0.00 0.00 0.00 234,158.20
37 6/1/2024 0.00 0.00 0.00 0.00 234,158.20
38 12/1/2024 0.00 0.00 0.00 0.00 234,158.20
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Amortization Table

The amortization table at the end of this worksheet calculates the principal and interest paymenits, ending balance,
and cumulative interest for any 48 consecutive payment periods of a loan.
# To use the tahle, change the values in the Inital Data section of the worksheet.
# To print the table, choose Print from the File menu. The print area is set to A1:G77.
& If you increase the term of the loan or the number of payments, you will need to add more payment periods

to the table. Select cells A75:G77, then drag the Fill handle (+} into the cells below the table.
# Most formulas on this worksheet are contained in defined names. To see the names and formulas,

choose Name from the insert menu, and then choose Define. Select a name from the list

(‘Amortization Table'linterest, for example).

TABLE DATA
Table starts at date:
or at payment number:{1

LCAN DATA

Loan amount:| $2,150,000.00
Annual interest rate:[9.00%.

Term in years:|19

Paymenfs per year:

2

First payment due:|6/1/2005

PERIODIC PAYMENT

Entered payment:  $30,743.00 The table uses the calculated periodic payment amount,
Calculated payment: $119,113.64 unless you enter a value for "Entered payment.”
CALCULATIONS
Use payment of.  $790,251.00 Beginning balance at payment 1:  $2,150,000.00

1st payment in table:

1

Cumulative interest prior to payment 1:

$0.00

Payment Beginning Ending Cumulative
No. Date Balance Interest Principal Balance Interest
1 6/1/2005 2,150,000.00 96,750.00 0.00 2,246,750.00 101,103.75
2 12/1/12005 2,246,750.00 101,103.75 0.00 2,347,853.70 202,207.50
3 6/1/2006 3,447,853.70 155,153.42 0.00 3,603,007.10 357,360.92
4 12/1/20086 3,603,007.10 162,135.32 0.00 3,765,142.40 519,496.24
5 6/1/2007 3,765,142.40 169,431.41 0.00 3,934,573.80 688,927.64
6 12/1/2007 3,934,573.80 177,055.82 0.00 4,111,629.60 865,983.47
7 6/1/2008 4,111,629.60 185,023.33 0.00 4,296,652.90 | 1,051,006.80
8 12/1/2008 4,296,652.90 193,349.38 0.00 4,490,002.20 | 1,244,356.18
9 6/1/2009 4,490,002.20 202,050.10 0.00 4,692,052.30 | 1,446,406.28
10 12/1/2009 4,692,052.30 211,142.35 0.00 4,723,103.60 | 1,657,548.63
11 6/1/2010 4,723,103.60 212,539.66 0.00 4,755,552.20 | 1,870,088.29
12 12/1/2010 4,755,562.20 213,999.85 0.00 4,755,652.20 | 2,084,088.14
13 6/1/2011 4,755,552.20 213,999.85 14,188.15 | 4,741,364.05 | 2,298,087.99
14 12/1/2011 4,741,364.05 213,361.38 14,826.62 | 4,726,537.43 | 2,511,449.37
15 6/1/2012 4,726,537.43 212,694.18 143,306.82 | 4,583,230.61 | 2,724,143.56
16 12/1/2012 4,583,230.61 206,245.38 149,755.62 | 4,433,474.99 | 2,930,388.83
17 6/1/2013 4,433,474.99 199,506.37 256,868.63 | 4,176,606.36 | 3,129,895.31
18 12/1/2013 4,176,606.36 187,947.29 268,427.71 | 3,908,178.65 | 3,317,842.59
19 6/1/2014 3,908,178.65 175,868.04 361,380.96 | 3,546,797.69 | 3,493,710.63
20 12/1/2014 3,546,797.69 159,605.90 377.643.10 | 3,169,154.59 | 3,653,316.53
21 6/1/2015 3,169,154.59 142,611.96 394,637.04 | 2,774,517.55 | 3,795,028.49
22 12/1/2015 2,774,517.55 124,853.29 412,395.71 | 2,362,121.84 | 3,920,781.78
23 6/1/2016 2,362,121.84 106,295.48 502,197.52 | 1,850,824.32 | 4,027,077.26
24 121112016 1,869,924.32 83,696.5% 524,7968.41 | 1,335,127.91 ] 4,110,773.85
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Payment Beginning Ending Cumulative
No. Date Balance Intarest Principal Balance Interest
25 6/1/2017 1,335,127.91 60,080.76 603,729.24 731,398.67 4,170,854.61
26 12/1/2017 731,398.67 32,912.94 630,897.06 100,501.61 4,203,767.55
27 6/1/2018 100,501.61 4,522.57 100,501.61 0.00 4,208,290.12
28 12/1/2018 0.00 0.00 0.00 0.00 4,208,290.12
29 6/1/2019 0.00 0.00 0.00 0.00 4,208,290.12
30 12/1/2019 0.00 0.00 0.00 0.00 4,208,290.12
31 6/1/2020 0.00 0.00 0.00 0.00 4,208,290.12
32 12/1/2020 0.00 0.00 0.00 0.00 4,208,290.12
33 6/1/2021 0.00 0.00 0.00 0.00 4,208,290.12
34 12112021 0.00 0.00 0.00 0.00 4,208,290.12
35 6/1/2022 0.00 0.00 0.00 0.00 4,208,290.12
36 12/1/2022 0.00 0.00 0.00 0.00 4,208,290.12
37 6/1/2023 0.00 0.00 0.00 0.00 4,208,290.12
38 12/172023 0.00 0.00 0.00 0.00 4,208,290.12
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Amortization Table

The amortization table at the end of this worksheet calculates the principal and interest payments, ending balance,
and cumulative interest for any 48 consecutive payment periods of a loan.
¢ To use the table, change the values in the Inital Data section of the worksheet.
& To print the table, choose Print from the File menu. The print area is set to A1:G77.
& If you increase the term of the loan or the number of payments, you will need to add more payment periods

to the table. Select cells A75:G77, then drag the Fill handle (+) into the cells below the table.
& Most formulas on this worksheet are contained in defined names. To see the names and formulas,

choose Name from the Insert menu, and then choose Define. Select a name from the list

{'Amortization Table'interest, for example).

TABLE DATA
Loan amount:|  $600,000.00 Table starts at date:
Annual interest rate:|9.00% or at payment number:|1
Term in years:|19
Payments per year:|2.
First payment due:|6/1/2006
PERIODIC PAYMENT
Entered payment:  $30,743.00 The table uses the calculated periodic payment amount,
Calculated payment: $33,241.02 unless you enter a value for "Entered payment.”
CALCULATIONS
Use payment of:  $126,440,00 Beginning balance at payment 1: $600,000:00
1st payment in table: 1 Cumulative interest prior to payment 1. $0.00

Payment Beginning Ending Cumulative
No. Date Balance Interest Principal Balance Interest
1 6/1/2006 600,000.00 27,000.00 0.00 627,000.00 28,215.00
2 12172006 627,000.00 28,215.00 0.00 655,215.00 56,430.00
3 6/1/2007 655,215.00 29,484.68 0.00 684,699.68 85,914.68
4 12/1/2007 684,699.68 30,811.49 0.00 715,511.36 116,726.16
5 6/1/2008 715,511.36 32,198.01 0.00 747,709.37 148,924 .17
6 12/1/2008 747,708.37 33,646.92 0.00 781,356.29 182,571.09
7 6/1/2009 781,356.29 35,161.03 0.00 816,5617.32 217,732.13
8 12/1/2009 816,517.32 36,743.28 0.00 853,260.60 254,475.41
9 6/1/2010 853,260.60 38,396.73 0.00 858,914.33 292 87213
10 12/1/2010 858,914.33 38,651.14 0.00 868,822.47 331,523.28
11 6/1/2011 868,822.47 39,097.01 2,390.99 866,431.48 370,620.29
12 12/1/2011 866,431.48 38,989.42 2,498.58 863,932.90 409,609.71
13 6/1/2012 863,932.90 38,876.98 25,851.02 838,081.88 448,486.69
14 12M1/2012 838,081.88 37,713.68 27,014.32 811,067.56 486,200.37
15 6/1/2013 811,067.56 36,4088.04 46,478.96 764,588.60 522,698.41
16 12/1/2013 764,588.60 34,406.49 48,570.51 716,018.09 557,104.90
17 6/1/2014 716,018.09 32,220.81 65,461.19 650,556.90 589,325.71
18 12/1/2014 650,556.90 29,275.06 68,407.00 582,149.90 618,600.77
19 6/1/2015 582,149.90 26,196.75 71,485.25 510,664.65 644,797.52
20 12/1/2015 510,664.65 22,979.91 74,702.09 435,962.56 667,777.43
21 6/1/2016 435,962.56 19,618.32 91,016.68 344,945.88 687,395.74
22 12/1/2016 344,945.88 15,522.56 95,112.44 249,833.44 702,918.31
23 6/1/2017 249,833.44 11,242.50 115,197.50 134,635.94 714,160.81
24 12/1/2017 134,635.94 6,058.62 120,381.38 14,254.56 720,219.43
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Payment Beginning Ending Cumulative
No. Date Balance Interest Principat Balance Interest
25 6/1/2018 14,254.56 6841.46 14,254 .56 0.00 720,860.88
26 1211/2018 0.00 0.00 0.00 0.00 720,860.88
27 6/1/2019 0.00 0.00 0.00 0.00 720,860.88
28 121172019 0.00 0.00 0.00 0.00 720,860.88
29 6/1/2020 0.00 0.00 0.00 0.00 720,860.88
30 12/1/2020 0.00 0.00 0.00 0.00 720,860.88
31 6/1/2021 0.00 0.00 0.00 0.00 720,860.88
32 12/1/2021 0.00 0.00 0.00 0.00 720,860.88
33 6/1/2022 0.00 0.00 0.00 0.00 720,860.88
34 12/1/2022 0.00 0.00 0.00 0.00 720,860.88
35 6/1/2023 0.00 0.00 0.00 0.00 720,860.88
36 12/1/2023 0.00 0.00 0.00 0.00 720,860.88
37 6/1/2024 0.00 0.00 0.00 0.00 720,860.88
38 12/1/2024 0.00 0.00 0.00 0.00 720,860.88
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Amortization Table

The amortization table at the end of this worksheet calculates the principal and interest payments, ending balance,
and cumulative interest for any 48 consecutive payment periods of a loan.
& To use the table, change the values in the Inital Data section of the worksheet.
+ To print the table, choose Print from the File menu. The print area is set to A1:G77.
4 [f you increase the term of the loan or the number of payments, you will need to add more payment periods
to the table. Select cells A75:G77, then drag the Fill handle (+) into the cells below the table.

+ Most formulas on this worksheet are contained in defined names. To see the names and formulas,

choose Name from the Insert menu, and then choose Define. Select a name from the list

(‘Amottization Table'llnterest, for example).

TABLE DATA
Table starts at date:
or at payment number:|1

Loan amount:| $3,520,000.00
Annual interest rate:|6.00%
Term in years:|15
Payments per year:|2
First payment due:|6/1/2010

PERIODIC PAYMENT

Entered payment:  $30,743.00 The table uses the calculated periodic payment amount,
Calculated payment:  $179,587.79 unless you enter a value for "Entered payment.”
CALCULATIONS
Use payment of: $790,251.00 Beginning balance at payment 1:  $3,520,000.00
1st payment in table: 1 Cumulative interest prior to payment 1. $0.00°

Payment Beginning Ending Cumulative
No. Date Balance Interest Principal Balance Interest
1 6/1/2010 3,520,000.00 105,600.00 0.00 3,625,600.00 108,768.00
2 12/1/2010 3,625,600.00 108,768.00 0.00 3,734,368.00 217,536.00
3 6/1/2011 3,734,368.00 112,031.04 0.00 3,846,399.00 329,567.04
4 12/1/2011 3,846,399.00 115,391.97 0.00 3,961,790.90 444,959.01
5 6/1/2012 3,961,790.90 118,853.73 0.00 4,080,644.60 563,812.74
6 12/1/2012 4,080,644.60 122,419.34 0.00 4,203,063.90 686,232.08
7 6/1/2013 4,203,063.90 126,091.92 0.00 4,329,155.80 812,323.99
8 12/1/2013 4,329,155.80 129,874.67 0.00 4,459,030.40 942 198.67
9 6/1/2014 4,459,030.40 133,770.91 0.00 4,592,801.30 | 1,075,969.58
10 12/1/2014 4,592,801.30 137,784.04 0.00 4,730,585.30 | 1,213,753.62
1" 6/1/2015 4,730,585.30 141,917.56 0.00 4,872,502.80 | 1,355,671.18
12 12/1/2015 4,872,502.80 146,175.08 0.00 5,018,677.80 | 1,501,846.26
13 6/1/2016 5,018,677.80 150,560.33 0.00 5,169,238.10 | 1,652,406.58
14 12/1/2016 5,169,238.10 155,077.14 0.00 5,324,315.20 | 1,807,483.74
15 8/1/2017 5,324,315.20 159,729.46 0.00 5,484,044.60 | 1,967,213.19
16 12/1/2017 5,484,044.60 164,521.34 0.00 5,648,56590 | 2,131,734.63
17 6/1/2018 5,648,565.90 169,456.98 0.00 5,818,022.80 | 2,301,191.51
18 12/1/2018 5,818,022.80 174,5640.68 615,710.32 | 5,202,312.48 | 2,475,732.19
19 6/1/2019 5,202,312.48 156,069.37 634,181.63 | 4,568,130.86 | 2,631,801.57
20 12/1/2019 4,568,130.86 137,043.93 £53,207.07 | 3,914,923.78 | 2,768,845.49
21 6/1/2020 3,914,923.78 117,447.71 672,803.29 | 3,242,120.50 | 2,886,283.21
22 12/1/2020 3,242,120.50 97,263.61 692,087.39 | 2,549,133.11 | 2,983,556.82
23 6/1/2021 2,549,133.11 76,473.99 713,777.01 | 1,835,356.11 | 3,060,030.81
24 12/1/2021 1,835,3566.11 55,060.68 735,190.32 | 1,100,165.79 | 3,115,091.50
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Payment Beginning Ending Cumulative
No. Date Balance Interest Principal Balance Interest
25 6/1/2022 1,100,165.79 33,004.97 757,246.03 | 342,919.76 3,148,096.47
26 12/1/2022 342,919.76 10,287.59 342,919.76 0.00 3,158,384.06
27 6/1/2023 0.00 0.00 0.00 0.00 3,158,384.06
28 12/1/2023 0.00 0.00 0.00 0.00 3,158,384.06
29 6/1/2024 0.00 0.00 0.00 0.00 3,158,384.06
30 12/1/2024 0.00 0.00 0.00 0.00 3,158,384.06
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